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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by 
Mac NZ for this purpose only. Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

June 2017  
•2——Mac News ~ What a 

WWDC! Memory, Hitman, Cook, 
best games, iBooks, Dock,  

wired Numeric keyboard replaced 
•4——Updates ~ New Macs, new 

OS, Flash, iWork updates 
•6——Mac Help ~  

Around New Zealand 
•7—— iOS & iDevice news ~ iOS 
11 announced, new iPad Pro, App 

housecleaning, Siri translator, 
Memories ad, iOS problem 

•9——Apple & Talk ~ Pro Apples 
... yay! and Apple’s hidden 

busyness pays off  
•11——Tips & Tricks ~ macOS 

Safari, macOS Sierra, iOS Split 
View, Hotspots etc,  

and iOS/macOS medley 
•17——Shiny & New ~ First 

look at a 2017 MacBook Pro,Swift 
Publisher  

•18——How To ~ Get the  
most from Mac NZ

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

At the World Wide Developers’ Conference in San Jose, June 5th, Apple announced a new Mac: the iMac Pro, which will be 
available from December 2017 and cost over $8000 New Zealand dollars. The specs are dramatic. With next-generation Intel Xeon 

processors up to 18 cores, it’s designed to handle the most demanding pro workflows. It will have an all-flash architecture and 
all-new thermal design (shown above) to deliversup to 80% more cooling capacity in the same thin and seamless iMac design. It 

will have a 27-inch Retina 5K display with support for 1 billion colours (image from Apple’s iMac Pro newsroom page)
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Mac News > WWDC, memory outbid, Hitman, Cook drops in Glassdoor rankings

Quite a WWDC! 
By now you have probably heard about 
all the WWDC announcements – new 
iMacs, new MacBook Pros, and the 
announcement of a coming iMac Pro and 
macOS High Sierra and iOS 11.

Apple out of  memory bid
Toshiba has chosen a consortium formed 
by Bain Capital, Mitsubishi, and Japanese 
government investors as the preferred 

More news is online at Mac NZ

bidder for its memory chip business, 
effectively locking out a Foxconn-led 
consortium which included Apple and 
Dell.

It’s a Hitman
Feral Interactive has shipped Hitman for 
macOS, complete with all instalments of 
the episodic assassination-based game 
playable on Mac for the first time. The 
launch is accompanied by the release of 

a demo from developer IO Interactive, 
providing access to one episode from the 
series for free. [Expect your brain to be 
challenged, as it’s a stealth game.]

Cook drops in rankings
Apple’s Tim Cook has slipped from 8th 
to 53rd place in Glassdoor’s annual 
CEO rankings for large US businesses, 
based on anonymous reviews left by the 
company’s workers. This still gives him a 
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Mac News > iBooks love, new Dock, best games and sale, wired Numeric gone

93% approval rating in the poll, Glassdoor 
said. In 2016 Cook managed 96%, helping 
to elevate him from 10th place in 2015, and 
18th in 2013 and 2014. It’s not clear what 
led to Cook’s fall, although simply being 
in the top 100 puts him well above the 
67% average CEO rating for companies on 
Glassdoor.

Love for iBooks, iBooks Author
iBooks is a free ebook app that allows 
you to read publications purchased at 
the iBooks Store. iBooks Author lets you 
create iBooks textbooks (as well as other 
types of books) for the iPad and Mac. 
But the app and the service have been 
languishing [hear hear!].

Kensington Thunderbolt 3 Dock
Kensington has announced the general 
availability of its US$349.99 SD5000T 
Thunderbolt 3 Docking Station for macOS. 
It provides a bridge allowing more mobile 
and thinner devices access to a suite of 
gadgets on the user’s desk.
The standout feature of this one is it fits to 
the back of VESA-compatible monitors for 
zero footprint. 
We have yet to discover it will be 
available in New Zealand, but the Belkin 
Thunderbolt 3 Dock is and I hope to review 
this soon – in NZ it costs NZ$579.99.]

Best Mac games of  2017 (so far)
Ric Molina of MacGamer delivers a detailed post on the best Mac 
games of 2017. “Here at Mac Gamer HQ, we spend a lot of time 
talking about how great the gaming situation is on the Mac.” 
Among them is the WWII based Day of Infamy, which is appealing 
to this historian. This game also has relatively modest system 
requirements compared to some, and while we’re at it, Steam is 
having a big games sale (which includes some Mac games) until 
early July.

Wired Keyboard with Numeric Keypad replaced
One of Apple’s quiet updates during WWDC earlier this month 
was the long-awaited introduction of the Magic Keyboard with 
Numeric Keypad. The price of the only Apple-made keyboard 
with a numeric keypad just went up 163%, from the old wired 
keyboard’s US$49/NZ$85 price to the US$129/NZ$219 [!] price of 
the new wireless model. [iStore in Takapuna still has a few wired 
versions – Logitech makes cheaper wired and wireless versions.]

More news is online at Mac NZ
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New 27-inch 5K iMac has powerful graphics
Daniel Eran Dilger writes that Apple has radically overhauled its 
iMac lineup for 2017, giving its 27-inch Retina 5K models dedicated 
graphics driven by AMD Radeon Pro 570, 575, and 580 GPUs; a 
brighter display with enhanced P3 wide colour; more powerful 
Intel Kaby Lake CPUs; upgradable RAM sockets and modern, 
ultrafast USB-C and Thunderbolt 3 connectivity. Dennis Sellers 
calls it the best iMac ever. 
Apple announced at WWDC 2017 that its 21.5-inch Retina 4K 
models have dedicated graphics driven by AMD Radeon Pro 
555/560 GPUs; a brighter display with enhanced P3 colour; 
more powerful Intel Kaby Lake CPUs; upgradable RAM sockets; 
faster SSD drives and modern, ultrafast USB C and Thunderbolt 
3 connectivity. The entry-level 4K iMac now provides Intel’s 
7th Generation Kaby Lake quad-core Core i5 processor, which 
at 3.0GHz is notably more powerful than the 5th Generation 
Broadwell Core i5 used in the original “Late 2015” 4K iMac, 
despite being clocked 100MHz slower. Take a closer look at the 
updated all-in-one desktop in Apple Insider’s video review. But 
the 2017 iMacs won’t support Target Display Mode.

Updates > New Macs, new operating systems coming and more 

High Sierra video First Look
Video covers several of the marquee 
features of macOS 10.13 High Sierra.

NVMe Flash Storage in High 
Sierra’s future
The discovery that Apple has intentionally 
removed restrictions on NVMe in the High 
Sierra beta suggests that future Macs won’t 
be limited in which mass-storage flash 
drives may be used, possibly including both 
the ‘modular’ Mac Pro and the iMac Pro.

New 15-inch MacBook Pro
The revved 15-inch MacBook Pro goes up 
to 3.1GHz Core i7 with Turbo Boost up to 
4.1GHz and now comes standard with more 
powerful discrete graphics with more video 
memory. 
Overall and in general terms, tests show 
that it’s about 20% faster than its 2016 
counterpart, reckons Stephen Sandes.

iWork added Shape Libraries
Apple rolled out updates for Pages, 
Keynote, and Numbers on the Mac that 
add in more than 500 professionally drawn 
shapes in free updates. 
The iWork updates added support for 
replying to comments and joining threaded 
conversations, improved autocorrect and 
text and more.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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USB-C to USB Cable
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

IonGlass for 
iPhone 7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

USB-C to VGA adapter
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees a 
hassle-free setup for convenient home or office use
NZ RRP$69.99

USB-C Charge Cable
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with an Apple 
Retina MacBook, Google Chromebook Pixel, or 
any mobile device equipped with a USB-C port. At 
2 metres length (6.6 feet) in length, a HandyStrap 
is also included to keep your cable neat and tidy 
during transport 
NZ RRP$59.99

armour for  
iPhone 6-7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-ion-glass-for-iphone-7-plus
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-vga-adaptor
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-iglaze-armour-for-iphone-7
http://www.macgear.co.nz


>>

>
>

Mac NZ

page

6
MagBytes

#88

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

Apple support & AppleCare
Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac & iDevice training in 
Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ, so that’s quite a lot of free help. 
I can and do one-to-one or small group 
sessions at your home or workplace in 
Auckland. This costs $95/hour but I’m 
now only available for this on Mondays 
and Tuesdays, since I work at a museum. 
I can present to institutions on Mac and 
iDevice: tips, tricks, hidden features, 
demystification ...Email Mark for info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top), but the first 
thing you can do is open the Utilities folder 
on your Mac’s applications folder, and find 
Apple’s Disk Utility. Launch it, select your 
Mac’s internal hard drive which is normally 
called ‘Mac HD’ (or plugged in hard drive/
flash drive/camera card etc) and run First 
Aid over it. (iDevices are another story!)

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help > Apple assistance, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.
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iDevice news

Logitech ad

Driving inside iOS 11
Beginning this fall, iOS 11 will debut 
a new safety feature for Apple’s 
iPhone called Do Not Disturb While 
Driving. 
Apple Insider corralled a co-pilot to 
test it out, and here’s how it works.

New 10.5-Inch iPad Pro
Jeff Butts talks about the difference 
between refresh rate and FPS 
(frames per second) “because I have 
a feeling many folks are wondering. 
The new 10.5-inch iPad Pro boasts 
a 120Hz refresh rate, but what 
does that really mean in real-world 
terms? 
It’s clear that at least one writer 
covering the tech industry doesn’t 
quite grok the difference.” Basically, 
the frames refresh 120 times per 
second, even when your content 
only moves at 60FPS.
The 2017 12.9 iPad Pro gained 
feature parity with its smaller 
sibling. Staggered launches of the 
first generation of iPad Pro tablets 
left the larger 12.9-inch model in 
an awkward position, lacking key 
professional-grade features like 
always-on Hey Siri and a colour-
balancing True Tone display. Apple 

> iOS 11, new iPad Pro gets feature parity with the larger

More news is online at Mac NZ
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iDevice news> Apps cleaned, Siri to translate, Memories ad, iOS Verification

has rectified that with its 2017 12.9-inch 
iPad Pro, bringing it up to speed with 
the smaller 10.5-inch version with a 
simultaneous release. 
Apple Insider has compared the new 
model to older versions.

Apps cleaned 
As part of an extensive housecleaning 
operation, Apple has over the past year 
removed hundreds of thousands of clones, 
32-bit titles, spamware and other software 
from the App Store ahead of this fall’s iOS 
11 launch.

Siri to translate in iOS 11
Beginning this northern Autumn (our 
Spring) with iOS 11, Apple’s voice-driven 
personal assistant, Siri, will gain the ability 
to translate to multiple foreign languages. 
Here’s a peek at how it will work.

Apple shows off  Memories 
The Archives ad and tutorial video 
‘Practically magic’ campaign for the 
iPhone 7 has a new ad spot called The 

Archives which emphasises the Memories 
feature in Photos.

iOS Verification Failed Error

More news is online at Mac NZ

Some iPhone users have been plagued 
with an iOS Verification Failed message 
when trying to log in on iCloud.com. Apple 
has acknowledged the error.

mailto:mac.nz%40me.com?subject=From%20MagBytes
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apple&talk > Pro Apples ... yay!

For months now, commentators have 
been lambasting Apple for not updating 
Macs and for ignoring the pro users. I 
have regularly been a minor part of that 
pool of despond in this column.
No more! We’re (mostly) very happy. 
Apple’s June 5th WWDC hardware 
announcements delivered a  gulp of elixir 
– the Apple Koolaid was back and we were 
slugging it down. For a heady day or two, 
anyway. I immediately, gleefully ordered a 
15-inch MacBook Pro with Touch Bar. The 
Kaby Lake CPU was the tipping point I was 
waiting for. It wasn’t even that Kaby Lake 
gives a significant increase of power – it 
doesn’t. It’s just that I didn’t want to drop 
cNZ$5k onto a new Mac without Kaby Lake 
when I knew it was available, and already 
populating many PC models. I can hardly 
wait for my new Mac to arrive, since my 
current model is 5 years old – that’s a very 
long life for a Mac for me (and truth be 
told, it’s still a wonderful laptop).

But the really big news, for the pros, was 
the iMac Pro. Although this will cost over 
NZ$8000, by current exchange rates, it’s 
not for the typical iMac users – they have 
been catered to with new iMacs anyway, 
with even better screens and Kaby Lake and 
at much more affordable prices. Even these 
will very handily handle major Apple Final 

Cut and Adobe Premiere tasks without 
breaking a sweat.
But the iMac Pro is aimed at the very 
serious user, as the bedrock to, for 
example, an audio, audio visual or video/
TV/film editing studio, and although 
that’s a lot of money, hey, it already has a 
fantastic screen and has real grunt. Even 
more interesting, perhaps, is that unlike 
the current Mac Pro (tower), it’s almost 
impossible to put together a similar PC and 

monitor setup for less than what the iMac 
Pro will cost – in fact, Apple’s new machine, 
due in December, is actually a bargain. And 
despite it, Apple has also announced it is 
working on a new, user-upgradeable Mac 
Pro tower.
Good timing, too, since for the first time in 
a long time, it looks like the PC market will 
start growing again. So yes, Apple, we’re 
happy – and, sincerely, thank you!

But no word on the Mac mini. If Apple’s 
keeping it in the Mac lineup, surely it 
deserves Kaby Lake? 
No mention of AirPort, which I think Apple 
is mad to drop if  the company wants us 
to have seamless wifi connectivity with 
our Apple devices to the new HomePod it 
also announced, and if Apple is thinking 
of palming this off to a third party router 
supplier, then I visit the ghost of the LG 4k 
monitor debacle on you, Apple! (If you want 
something done properly …)
No Magic Keyboard with Touch Bar – this 
looks like a brilliant idea, and you’d expect 
it if the Touch Bar is appreciated on 
MacBook Pro, but I suspect the connectivity 
and functionality over Bluetooth might be 
the stumbling block. 
I still want one, though! If you have a Track 
Bar on your MacBook Pro and then go to 
use, say, Final Cut on an iMac, surely you 
want that feature there too?
And no iBooks Author update. Apple 
has let its brilliant and dreadfully under-
appreciated eBooks platform languish far 
too long.

Still — a new iPhone has still to emerge 
(September, people reckon). Apple will 
doubtless have more news for us as the 
year progresses. For now, for Mac users, the 
happy times are here again.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/news/product-news/every-apple-hardware-announcement-wwdc/
https://www.macobserver.com/news/product-news/every-apple-hardware-announcement-wwdc/


>>

>
>

Mac NZ

page

10
MagBytes

#88

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

apple&talk > Has Apple ever been busy!

Everyone knew (and hoped) Apple was 
up to things, the gap between the 2016 
and the 2017 WWDC seemed to yawn 
cavernously on, with any glimmers of 
hope generated by eager commentators 
and aficionados while Apple remained 
monolithically silent. We all hoped Apple 
was crazy-busy behind the scenes, but 
there was little evidence to support that, 
thanks to the usual layers of secrecy, 
until the very welcome blockbuster 
announcements.
The hardware announcements appealed to 
almost everybody, but of course, WWDC 
is a developer conference. For the San José 
hordes to leave smiling, they needed more 
than a raft of new hardware to aspire to.
But Apple’s messages have been mixed. 
Apple recently more than halved affiliate 
fees people earn by directing their readers 
to Apple services, which just seems rude 
and uncaring considering how stinkingly-
wealthy Apple is. 
On the other there have been moves to 
both broaden and tighten the so-called 
‘Apple ecosystem’ in which every device 
you have is by Apple, and Apple tech and 
services connects them all up. Coders 
code  on Apple devices and in Apple 
environments, and users can’t really get 
into the hardware and software of those 
devices.

Some of these moves are very welcome. 
Apple will soon let the people who make 
podcasts learn what podcast listeners 
actually like – and what they ignore. A 
coming version of Apple’s Podcasts, which 
is by far the most popular podcast app, will 
provide basic analytics to podcast creators, 
giving them the ability to see when podcast 
listeners play individual episodes, and 
more importantly what part of individual 
episodes they listen to, which parts they 
skip over, and when they bail out of an 
episode.
This has been an annoyingly opaque world 
for far too long: launch your podcast into 
the ether and your only real feedback is 
how many people downloaded it, and the 
minimal user-feedback on iTunes.
iBooks is even worse – the authoring app 
dates back to 2012 and the awful truth only 
really dawns on you when you publish a 
book: sales are tiny because nobody really 
uses the iBooks platform (which is flat-out 
marvellous) and Apple seemingly cannot 
be bothered to put any effort into it or to 
properly promote it.
But the podcasts initiative is a sign of hope.

However, Apple is now clearly busy 
on several fronts. Self-driving machine 
learning is at the core of Apple’s car 
ambitions. We know this because Tim 

Cook said so. You know, in public. Business 
Chat will appear in iOS 11, which will work 
across Apple’ iPhone, iPad and Apple 
Watch, but not the Mac (at first, anyway). 
Apple customers will be able to start a 
conversation with a business from Safari, 
Maps, Spotlight, and Siri. Once again, inside 
that Apple ecosystem, all will be sweet – 
it’s just that some find this a constriction 
whereas most users find it a pure boon.
Tim Cook has also announced a wide range 
of software and hardware changes that 
will finally bring VR to macOS, and that’s 
pretty surprising because Tim Cook himself 
had been on record as giving “exactly zero 
damns about VR“. Which is good because it 
shows he’s flexible to new realities, right?

For some, of course, it has all been 
too much, even from the 2016 
announcements. When you think about 
it, a lot of the top announcements at 
the 2016 WWDC didn’t go far. How 
many people with 3D Touch-capable 
devices actually use it? It’s a shame as 
it’s remarkably useful. The same can’t 
be said for Stickers in Messages, which 
was froth, and very different most of the 
core tech and fundamentals of this year’s 
initiatives. WWDC showed a much greater 
commitment to the core of what makes 
people Apple fans. And I’m really happy.

(Speculative image 
from TechFrag)
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> macOS Safari gets ever more useful if  you know a few thingstips&tricks
1/ How to clear your Safari browsing 
history in macOS Sierra — You can remove 
all records that macOS Sierra’s Safari keeps 
of where you’ve browsed during a period of 
time you want. If your Mac and your other 
devices have Safari turned on to sync in 
iCloud preferences, your browsing history is 
removed from all of those devices.
Clearing your browsing history in Safari 
doesn’t clear any browsing histories kept 
independently by websites you visited. 
Choose History > Clear History, click the 
pop-up menu, then choose how far back 
you want your browsing history cleared.
When you clear your history, Safari removes 
all the data it saves as a result of your 
browsing, including the history of web 
pages you visited, the back and forward list 
for open web pages, Top Sites that aren’t 
marked as permanent, your frequently 
visited site list, recent searches, and more. 
You will need to log into services like 
Facebook again … so make sure you really 
want to remove all this data before you 
clear your Safari history.

2/ Bookmark folders — If you’re using 
Safari’s Favorites Bar (which can be 
revealed by choosing View > Show Favorites 
Bar from the program’s menus at the top), 
there are a few neat things you can do with 

folders full of bookmarks (Bookmarks 
menu, Add Bookmarks Folder). 
You can tell what bookmarks in the 
Favourites Bar are folders because of those 
tiny downward-caret-arrow things to the 
right of each one (above). Apple calls these 
Disclosure Triangles because clicking them 
always reveals things. 
If you click on one, you’ll note the Open in 
New Tabs option (shown above).
Choose that, and obviously the bookmarks 
within that folder will open in their own 
tabs, which is a fast way to launch a whole 
bunch of sites at once. If, however, you hold 
down the Option key on your keyboard 
before you click there, Open in New Tabs 
switches to Replace Tabs. 
This means any tabs you had in your 
existing Safari window will vanish and 
be replaced by the ones in the folder you 
chose. 
Neat!

3/ For an even faster way to do either of 
those things — Use the Command key or 
the Option key. If you hold down Command 
and click on any toolbar bookmarks folder, 
it’ll open the sites within in new tabs; hold 
down Option and click one, and Safari 
will replace your existing tabs like we just 
discussed.

4/ Set your folders to automatically 
replace existing ones with just a click — 
To configure that, right- or Control-click on 
the folder and pick Automatically Replace 
Tabs from the contextual menu.
That will add a little square next to the 
folder in your toolbar, which will mean a 
single click will replace all of your existing 
tabs with the ones in that folder. (Be 
careful about doing that accidentally. If 
that happens, there are ways to recover 
your lost tabs.)

5/ Some of this functionality is available 
from the bookmarks sidebar if you 
prefer that view — For example, you can 
right- or Control-click on folders from there 
to pick Open in New Tabs. Holding down 
the Option key will switch that to Replace 
Tabs, as it does in the toolbar. [These last 
four tips came from The Mac Observer, 
which has more pictures.]

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/tips/quick-tip/safari-bookmarks-folders-tips/
https://www.macobserver.com/tips/quick-tip/safari-bookmarks-folders-tips/


>>

>
>

Mac NZ

page

12
MagBytes

#88

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2017. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip 
Enterprises 
2010-2017.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission, 
please   
email 
Mac NZ 

tips&tricks > A mix of  tips for macOS Sierra

1/ Change the default search scope in 
the macOS Sierra Finder — The macOS 
Sierra Finder is the home base for your 
Mac. You use it to organize and access 
almost everything on your Mac, including 
documents, images, movies, and any other 
files you have. When you do a search, the 
Finder will search through your entire Mac 
to find what you’re looking for. However, 
you can change the default search scope:
In the Finder (i.e., then the word to the right 
of the Apple icon at top left is ‘Finder’ – this 
is where you tell what the ‘foremost’ app 
or program is on a Mac), click on this Finder 
menu and select Preferences from the 
drop-down menu.
Click the Advanced tab.
Navigate to the bottom of the Preferences 
window and locate the drop-down menu 
labelled ‘When performing a search’ and 
click on it.
You’ll have three options from which to 
chooses: Search This Mac, Search the 
Current Folder and Use the Previous Search 
Scope. Pick the one you want.

2/ Hidden Display options — Displays on 
Mac just get better and better, but Apple 
has simplified the interface that drives 
them in macOS 10.12 Sierra and the Detect 
Displays button now appears to be missing. 
The option in System Preferences>Displays 

is still there, and there are others, revealed 
a simple keystroke: it appears when 
you hold down the Option key on your 
keyboard, the Detect Displays button 
replaces the Gather Windows button at 
lower right – this is handy if your Mac 
has somehow ‘lost’ one of your attached 
monitors or projectors.
Another feature you can take advantage 
of lies in setting the resolution for your 
display. With the Scaled option selected, 
you’ll see quite a few native resolutions for 
your monitor and graphics chip. However, 
if you press the Option key as you click the 
Scaled radio button, you’ll see even more 
resolutions for you to pick from if you have 
a non-Apple secondary monitor plugged 
in (it does not work for built in displays, at 
least not in my case). But be careful with 
the resolution choices, as some of them 
might not be native to your display or Mac. 
That means they might not work out for 
you, even though they’re listed.

3/ Connect a USB printer in macOS 
Sierra — The default printer is the one 
selected when the Print dialogue opens. If 
‘No printer selected’ shows up instead in 
the Print dialogue, you’ll need to add a new 
printer.
For most USB-connected printers, all you 
have to do is update your software then 

connect the printer to your Mac. macOS 
can automatically detect the printer and 
download any necessary software. But for 
other printers, you may have to complete a 
few steps to add the printer. Here’s how.
Update your software: choose Apple menu 
> App Store, click Updates, then install any 
software updates listed. Even if no updates 
appear, this ensures that macOS has the 
latest information about printer software 
it can download from Apple. If you don’t do 
this, you may see a message that software 
isn’t available when you connect your 
printer.
Prepare your printer: use the instructions 
that came with your printer to unpack the 
printer, install ink or toner, and add paper. 
Turn on the printer and make sure it’s not 
displaying any errors.
Connect your printer: connect the USB 
cable to your Mac. If you see a message 
prompting you to download new software, 
make sure to download and install it.
Important: If your Mac has a single USB-C 
port, use a multiport adapter. Connect the 
printer, then connect a USB-C cable to a 
power supply to prolong the battery life of 
your Mac.
Go to System Preferences, and choose 
Printers & Scanners.
If a printer appears in the list, you can click 
on it. If none appears, click the “+” icon To 
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tips&tricks > macOS Sierra continued (a mixture)

remove a printer, click the “-“ icon. [From 
Apple World Today.]

4/ Always start new iWork documents 
with a specific template — Pages, 
Numbers and Keynote just got free updates 
with lots of new features, so why not have 
them work more usefully for you on first 
launch? If you prefer to always start with 
a blank document, or if you regularly use 
one particular template, you can configure 
Pages to start out with that selection 
instead of the Template Chooser. This also 
works with Numbers and Keynote, by the 
way. Here’s how to configure the app to 
start new documents the way you want.
By default, this is what you see when you 
opt to create a new document in Pages
This configuration setting is located within 
the Preferences menu in Pages for macOS. 
Just click Pages in the upper left corner of 
the menu bar, then choose Preferences 
from the drop-down menu.
You’ll probably notice that the top 
option from the General pane, Show 
Template Chooser, is selected beside For 
New Documents. Below that, you’ll see 
an option labelled Use template. Click 
the radio button to select that choice. 
When you select Use template, it will 
probably automatically choose the Blank 
document. If that’s what you want, exit 

the Preferences pane. If you want to use 
a different template, click on Change 
Template.
Now, a new window will open to allow you 
to choose your default template. Scroll 
through, make your selection, and then 
click Choose. Now, every time you open 
a new document in Pages (or Numbers 
or Keynote, as you can change those 
preferences, too) it will begin with the 
template you selected. If you regularly 
create documents from a particular 
template, or always generate your files 
from scratch, setting this option will save 
you a mouse click or two.

5/ Prevent Photos and iTunes from 
opening automatically on Macs when 
you plug in an iPhone or iPad — When 
you plug an iDevice into your Mac, you 

might have noticed that iTunes and Photos 
open. If you’re looking to sync music over to 
your device or import pictures, that’s great; 
however, if all you want to do is charge the 
device while you’re at your computer, then 
having to quit a couple of pesky programs 
is less awesome.
Both applications have a way to disable this 
behaviour, though. Start by plugging in the 
device, and then if necessary, click on the 
small icon in the toolbar [shown at left] to 
access its settings.
When that next screen appears, look under 
the “Summary” tab to find “Automatically 
sync when this [device] is connected” 
(which may instead say “Open iTunes when 
this [device] is connected”).
Uncheck that box and click ‘Apply’ in the 
bottom-right corner.
Photos’ option is just as easy to find. 

Plug in your iPhone or iPad as 
before, and then depending on your 
configuration, you may have to either 
click on the “Import” tab at the top, 
or choose the device itself from your 
sidebar. Then you should see a little 
checkbox near the top-left of the 
window labelled Open Photos for this 
device.
Uncheck that, and you’re all done – 
when you plug in that iPhone or iPad 
now, neither program will open.
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tips&tricks > Working smarter in iOS with Split View, Hotspots and more

1/ Split View on iPhone 6 Plus, 6s Plus 
and 7 Plus — Split View on the iPhone 7 
Plus can make you more productive. It’s not 
the same as Split View for iPad – you can’t 
multitask with it but you can use Split View 
mode on iPhone 7 Plus be more productive 
in certain apps.
This mode, activated in iOS 10 by turning 
your iPhone to landscape orientation, 
works in apps like Mail, Calendar, 
Reminders, Safari and more. It provides 
you with a two-column view, making more 
efficient use of the screen real estate so you 
don’t have to tap the back button as often. 
Split View is also available on the iPhone 6 
Plus and iPhone 6S Plus.

2/ Using your iPhone as a Personal 
Hotspot — Why get an iPad with Cellular if 
you only ever occasionally go online when 
you can use your iPhone, which already 
has that ability, to get your WiFi-only iPad 
online anyway? At least, if you can’t find 
wifi. Setting up a wireless hotspot on your 
iOS device is simple. You’ll need to make 
sure your cellular service plan supports 
the wireless hotspot feature (Vodafone NZ 
definitely does). If it doesn’t, check with 
your carrier for plan pricing and availability.
Also, you’ll need to make sure your iPhone 
or iPad has mobile data switched on, as if 
you do have and use a cellular-equipped 

(with SIM slot) iPad, you can also use 
that to get a Mac online when you’re 
somewhere and can’t find Wi-Fi, but 
cellular service is available.  Lastly, keep in 
mind that any data you use will most likely 
count against your plan’s data cap, so you’ll 
want to avoid downloading massive files 
while on the hotspot.
Open the Settings app and tap Personal 
Hotspot (it’s listed as Cellular Data on 
the iPad). Then, on the next screen, tap 
the Personal Hotspot switch so it’s in the 
“on” position (the switch will turn green). 
Next, make a note of your Wi-Fi password 
listed on this screen. If you don’t have Wi-Fi 
enabled on your iPhone or iPad, you’ll be 
asked to switch it on at this point.
On your Mac, open the Wi-Fi network 
menu, then select your iOS device’s name 
and enter the password as you would 
normally do when you connect to a Wi-Fi 
network.

That done, go back to Settings > Personal 
Hotspot (or Settings > Cellular Data > 
Personal Hotspot) and switch off the 
hotspot.
If you’ve got an iPhone or cellular-equipped 
iPad running iOS 8 or later and a Mac 
running OS X Yosemite or later (and you 
have both devices set up under the same 
Apple ID) you can easily activate your iOS 
device’s hotspot feature from the comfort 
of your own Mac. For this to work, both 
devices need to meet Apple’s Continuity 
system requirements.  From there, it’s a 
simple matter of selecting the hotspot-
enabled iOS device from the Wi-Fi menu in 
your Mac’s menubar.
This method works between iOS devices 
signed in under the same Apple ID: Go to 
Settings > Wi-Fi  on the device you want 
to connect to the hotspot, then select the 
hotspot-enabled iPhone or iPad.

3/ Enable Find My iPhone — Find My 
iPhone is a bit confusing from a privacy 
standpoint, but most people will benefit 
more from using it then not. With Find 
My iPhone enabled, you can track a lost 
phone using iCloud, and you can wipe your 
phone remotely. Apple will have access to 
the same information, so it boils down to 
whether you want to keep the data out of 
Apple’s hands (in which case you shouldn’t 
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tips&tricks > iOS continued, and another medley for macOS

use an iPhone at all) or out of a thief’s 
hands.

4/ For security, disable certain home 
screen features — Head to Settings > 
Touch ID & Passcode and look for ‘Lock 
screen access’. Remove anything that gives 
someone access to your personal info, like 
the Today View, Siri and Wallet. You might 
also want to disable Reply with Message 
here, since someone could reply to an 
incoming message without unlocking your 
phone.

5/ Security: disable tracking — Head 
to Settings > Privacy > Location Services 
> System Services and turn off Frequent 
Locations. This is a Maps feature that 
tracks where you go often under the guise 
of improving search.
Turn off contact, photo, email, calendar 
or location access in apps that don’t need 
it: Head to Settings > Privacy. Here, you’ll 
see a list of a bunch of different system 
services, including location and contacts. 
These are the iPhone services you can grant 
apps access to. There might be some apps 
in here you don’t remember authorising or 
you just don’t want any more. 
Tap a service, then go through and disable 
any app you don’t want to access that 
service.

1/ How to Force Quit an unresponsive 
app in macOS Sierra — Of course, try 
quitting it in the normal way first by 
choosing Quit from the app’s menu in the 
menu bar, or press Command and while 
it’s held down, the Q key, or click-and-hold 
on the app’s icon in the Dock and choose 
Quit from the pop-out menu that appears.
But if a Mac app acts up and you have to 
stop it running, you may have to force it to 
quit so you can relaunch it. Here’s how you 
use Force Quit in macOS Sierra:

Choose Force Quit from the Apple () 
menu, or press Command-Option-
Esccape (Esc at top left of your keyboard) 
all together.  (This is similar to pressing 
Control-Alt-Delete on a PC.)
Select the app in the Force Quit window, 
then click Force Quit.

2/ Automatically select the best email 
account in macOS Sierra — You can have 
Mail in macOS Sierra automatically select 
the best email account for a new message 
based on who the email is addressed to 
and what mailbox you selected when our 
began composing your new email.
With Mail up and running, click Mail, then 
Preferences from the top menus.
Click on the Composing tab.
There is a drop-down next to Send new 
messages from. Choose that to view your 
options.

3/ Archive information out of the 
Contacts program — In Apple’s Contacts 
app, Choose File > Export > Export vCard. 
This works for any individual card you have 
selected, but also for entire groups if you 
select one on the left, or All Contacts for 
all of them.
Once you’ve selected File > Export > 
Export vCard, your Mac will ask you where 
you’d like to save it, and you’re done! This’ll 
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tips&tricks > macOS medley continued – & we open Playlists separately again

create a .vcf file in your chosen location, 
and if at any point you’d like to bring back 
those people, just double-click on the file 
to re-import their cards.

4/ Check for malicious extensions in 
Safari — If you find that your browser is 
still acting weird, you may need to look to 
see if the adware you picked up added an 
unwanted extension to Safari.
Safari extensions are software programs 
you can install to customise the way your 
browser works. For example, extensions 
can show news headlines in a bar below 
the toolbar, change the appearance of 
web content, or add buttons to the Safari 
toolbar.
In order to provide these features, 
extensions may access the content of the 
web pages you visit. It’s good practice 
to check which extensions you have 
installed and make sure you are familiar 

with what they do. To check, open the 
program, then click on Safari > Preferences 
from the menus at the top. Choose the 
Extensions tab at the top, and you’ll see 
the list of what’s been installed. If you 
see something in your own list you’re 
unfamiliar with, you can either disable it 
by deselecting the checkbox I’ve indicated 
above or remove it completely using the 
Uninstall button.

5/ Open a playlist in a new window in 
iTunes 12.6 on macOS Sierra — With the 
release of iTunes 12.6 on macOS Sierra, 
Apple restored the ability [YAY!] to open a 
playlist in a new window. Why this feature 
was ever removed shall forever remain a 
mystery. But here’s how you can open a 
playlist in a new window.
Launch iTunes. Control-click or right-click 
on the playlist you want to open and 
select Open in New Window. That’s it.
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shiny&new > 2017 15-inch MacBook Pro with Kaby Lake; Swift Publisher

Swift Publisher makes pages
Belight’s Swift Publisher is designed 
to handle page layout for newsletters, 
magazines and more with a huge amount 
of shapes and image tiles to draw on for 
drag-and-drop designing. A Backgrounds 
line of thumbnails down the left side 
contains patches, but there are actually 
33 different categories in this list from 
Agriculture to Travel & Leisure. Below 
those, ‘Deposit Photos’, ‘Buy additional 
Clipart’ and ‘Search Results’. While not 
yet up to the ease of use and power of 
Adobe InDesign, each version adds more 
usability and features, and hey, no monthly 
subscription to pay. 
Swift Publisher, US$19.99

2017 MacBook Pro 15-inch with Kaby Lake CPU
I was waiting for a new MacBook Pro but I waited right through the 2016 model, because 
I knew Intel’s newer Kaby Lake generation of CPU was about to be available. This year’s 
model fitted the Kaby Lake and I’ve had the chance to check one out. 
Since it’s lighter and more powerful than my venerable (but still great, btw) 2012 15-inch 
MacBook Pro, it’s jump time for me – it’s been a long five years. 

Basic improvements, apart from the Touch 
Bar which adds fingertip control to all 
sorts of apps and a much bigger Track Pad, 
are welcome, but the real benefits for pro 
users are faster SSD technology (5.4x faster 
than my speedy 2012 model) and more 
powerful processors, plus a discrete 2GB 
GPU Radeon Pro 560 (with a 4GB option).  
Geekbench underlines the improvements 
– it’s a little faster than the 2016 MacBook 
Pro line with Touch Bar, thanks to Kaby 
Lake, but compared to my 2012 model the 
increase is more dramatic (some pretty 
basic figures appear in the chart, left, with 
the 2017 model in blue – surprisingly, the 
yellow bar for the 13-inch model has faster 
integrated graphics).
Only four ports ... they might be daisy-
chainable, but I regularly have three other 
hard drives plugged in, a USB extended 
keyboard, another monitor, Ethernet, an 
audio interface, a third set of speakers 
(additional to the ones plugged into the 
audio interface). 
Still, I’m so-far super-impressed – it’s safe 
to say, I’m in love with Mac again.

I used Swift Publisher to start making this eMagazine,  
MagBytes, and it’s not far off at all from being the 

replacement for Adobe Indesign I’ve been looking for. Swift 
is quick to learn with powerful graphics capabilities.  

With easier link management, I think I’m in. 
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> How to use the MacNZ site (www.mac-nz.com)

This is a free service – I run Mac NZ to help people to stay informed. The few ads just pay for Mac NZ web hosting.

Mac NZ reaches up to 6000-10,000 a month people via 

emails, tweets, Facebook, LinkedIn and direct clicks

Make this your Home Page: go to Mac NZ in Safari, open Preferences from the Safari menu, click the 
General tab & click ‘Set to Current Page’ to get instant Apple news whenever you launch your browser

How&To

Short bio 
& author 

picture

Click these headers 
for more information

Click the 
magnifying 

glass to search 
topics through 

the site

Filters: to filter 
to topics, click 

words to only 
see posts 

relating to these 
keywords 

Back issues 
of  this very 

PDF magazine 
available from 

this filter 
(all free). 

Just click and 
explore

Quick-browse 
recent posts

Click ‘Follow’ 
to get an 

email every 
time I publish 

(twice a 
day, 6 days 
a week ...) 
The email 

is complete 
and has all 

the news in 
it, with links, 
so you don’t 

even need to 
visit the site
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